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1. Introduction to ProviderLink 

What is ProviderLink? 
Unique to the healthcare industry is our interdependence on each other. Rarely can a job be performed without 
successful external communications. Before you can do your job, you must get an authorization, signature, 
order, medical record, referral, form, bed availability, etc. from someone else who typically does not report to 
you or even work for your organization. Herein lies the fundamental healthcare administrative problem. We are 
interdependent on each other but not necessarily accountable to each other.  
ProviderLink is an Internet communications tool that allows you to communicate patient information with other 
healthcare facilities or professionals. Instead of being tied to a particular fax machine or telephone extension, 
you can access ProviderLink anywhere you have an Internet connection. 
Any document, whether electronic or handwritten, or any other information about a patient can be placed in the 
patient record and securely sent to recipients. As long as the document can be printed or faxed, it can be loaded 
into ProviderLink and attached to a patient record.  
Whether the organizations you communicate with are online with ProviderLink or not, you can use ProviderLink 
to track any messages to or from them. For facilities that are online with ProviderLink, every message you send 
to them appears on their computer screen. If the facility is not yet online, you can still fax them messages and 
use ProviderLink's fax-back, cover sheet to have any replies automatically routed back to the appropriate patient 
record. In either case, ProviderLink streamlines all of your communications. 
Whenever you are transmitting patient records, you should be concerned about security and HIPAA compliance. 
ProviderLink helps customers with their HIPAA compliance. Every message sent or received by ProviderLink is 
logged and is date/time stamped. You can see when a message is sent, when it was read, and who read it. All 
messages are patient specific, meaning they are logged with and follow the patient record. You will always be 
able to see the complete patient history in ProviderLink. The data stored in ProviderLink is secure and backed 
up several times each day. 

Benefits of Using ProviderLink  
Each organization and each department within an organization has different communication needs and 
ProviderLink has features to address them all.  
Here are some of the benefits current customers of different provider types have enjoyed since coming online 
with ProviderLink: 

Skilled Facilities 
• Receive referrals from hospitals electronically 

• Pager notification lets you know the moment a referral arrives 

• Electronically receive and process Medicaid authorizations and prior approvals 

• Broadcast referrals to assisted living, nursing homes, and other facilities 
Hospitals 

• Utilization Review 
 - Less time spent faxing and on the phone 
 - Extensive history and audit trail 

• Discharge Planning 
 - Less time spent faxing and on the phone 
 - Electronically obtain prior authorizations from participating agencies 
-  Broadcast a referral (e.g., SNF, HME/DME, HHA, etc.) with just a few mouse clicks 
-  Referral replies are directly attached to the patient records 

• Business Office 
- Electronically receive requests for medical records 
- Respond to requests more quickly to shorten the A/R cycle 
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• Outpatient Services 
-  Central fax server allows central processing of all physician orders 
-  Workflow management for outpatient processes 
- Streamline internal communication processes in one workflow 

HME/DME 
• Manage physician signature collections for Certificates of Medical Necessity 

• Electronically obtain Medicaid or private payor approval 

• Electronically store Medicare DMERC forms 

• Receive referrals from facilities electronically 

• Pager notification lets you know the moment a referral arrives 
Payors 

• Less time managing faxes and on the phone 
• Create online authorizations and schedule upcoming reviews 

• Copy clinical information into your other systems 

How This Guide Is Organized 
Section 1 – The Introduction To ProviderLink section gives a basic overall introduction to ProviderLink and 
explains how to use this training guide to get the best results. 
Section 2 - The Hands-On Tour of ProviderLink section outlines the basics of navigating through the 
ProviderLink application. You will apply the concepts you learn here throughout your day-to-day procedures. 
Section 3 - The Using ProviderLink In Your Daily Work section describes how the features of the ProviderLink 
application work and how each department's users can get the most benefit from using them. 
Section 4 - The Appendix section describes how to troubleshoot issues encountered while using ProviderLink. 

Conventions Used In This Guide 
Using the mouse is key to effectively using ProviderLink. When the instructions say to click, it refers to a single 
click of the left mouse button. This is the main difference of navigating and working in ProviderLink as most 
commands require a single click.  
There will be times when the instructions will ask you to double-click on items. This refers to two rapid clicks of 
the left mouse button. Double-clicking in ProviderLink is relatively rare. 

CONVENTIONS USED IN THIS SUPPORT MATERIAL 

Definition Example 

If you need to press a key on your keyboard, the text on the key will appear in 
a bold text. Press the Enter key. 

When you need to click a link or a button on the screen, the link or button 
name will appear in bold text.  Click the Submit button. 

When you are asked to use the menu bar, the instructions will include bold 
text and arrows ( > ).  Lookup > Facility 

A tip or important note providing helpful hints, requirements, or other important 
notes is indicated by the symbol to the right.      

The book icon is used to introduce an idea or concept for the first time. 
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2. A Hands-On Tour Of ProviderLink 

How Do I Access ProviderLink? 
ProviderLink is a browser-based web application, meaning it runs completely in an Internet browser requiring no 
additional hardware or software. You can access ProviderLink from virtually any computer as long as it is 
connected to the Internet. While ProviderLink may work in other web browsers, Microsoft Internet Explorer 
version 6.0 or 7.0 is recommended.  
After receiving an email notification from your Security Administrator that you are registered, you must log in to 
ProviderLink to complete the registration process.  
To Access ProviderLink: 

1. Using a computer that is connected to the Internet, open Microsoft Internet Explorer (IE). 
2. In the IE window Address bar, type https://healthcare.covisint.com and press the Enter key. The 

Covisint login screen will appear. 
a. Enter your User ID and Password. 
b. Click Login. 

Figure 1 - Covisint login screen 

 
Note: The Password is case-sensitive and, when you log in, you will need to enter it exactly as you 
set it up. The system will prompt you to change your Password every 90 days. 
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3.  The Covisint Healthcare home page displays. In the left-hand menu, under Secure Applications, click 
ProviderLink to launch the application.  

Figure 2 - Covisint Healthcare home page 

RESULT: 

The ProviderLink application opens in a new Internet Explorer window.  

 
4. The FIRST time you login to ProviderLink, the ProviderLink Terms and Conditions of Use Agreements 

screen displays (Note: It will not display the next time you log in). Scroll down to the BOTTOM of the 
screen and click the Yes button to accept the terms of the agreement.  

Figure 3 - ProviderLink Terms and Conditions of User Agreements screen 
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5. The ProviderLink News screen displays. After reading the ProviderLink News, click the Proceed to 
Application button. 

 Figure 4 - ProviderLink News screen 

6. The Choose a Facility screen displays. IF you are a multi-facility domain, select your facility from the 
drop-down list. Skip this step if you are a single-facility domain. 

 
Figure 5 – Choose a Facility screen 
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7. The Choose Work List View screen displays. Choose Work List View can be thought of as a caseload, 
or “in basket.”  
a. Click the View drop-down arrow to select the work list you wish to view. The work lists are listed 

alphabetically.  
b. Click the Submit button.  

Figure 6 - Choose Work List View 

 
Note: “All Work Lists” is a special view that displays all of the patient records in all of the work lists. 
Generally, it is not used as part of a typical workflow. 

 

RESULT: 

After selecting a Work List View, you will be taken to the Main Window, which includes the list of patients in 
the selected work list. 

Failed Login 
The ProviderLink application is a secure system that only allows users who provide the right credentials to enter. 
In other words, you must provide a valid User ID and Password to successfully log into ProviderLink via the 
Covisint login screen (see Figure 1). If you mistype either of these, you will not be allowed to enter, and the 
system will display the failed login message, “You have entered an invalid password and/or User ID, please try 
again.” 
If you receive this message, check to make sure your User ID is spelled correctly. Then, re-enter your 
Password, keeping in mind that the Password is case sensitive.  

User Account Suspended 
If you enter an incorrect password 5 times within 5 minutes, your Covisint account will be locked due to an 
excessive number of invalid login attempts. As part of Covisint's comprehensive security design, accounts are 
automatically locked when it appears someone is trying to guess the password. 
In order to unlock your account, simply use your challenge question and answer to reset your password. This 
will automatically unlock your account. 

1. From the https://healthcare.covisint.com page: 
a. Click Forgot your password? in the bottom left corner of the Covisint login screen.  
b. The screen expands displaying a field to enter your User ID and then click Submit. The Reset 

Password screen displays. 

  
Document Revision Level 3.0                                                          - 8 -                                                                                      October 2009 
2009 Compuware Corporation: All Rights Reserved - Confidential and Proprietary 
 

https://healthcare.covisint.com/


A Hands-On Tour of ProviderLink 

c. Enter the answer to your challenge question in the Challenge Answer field and click Submit.  
Note: You create your Challenge Question and Answer during the registration process. 

d. Upon successful submission, the first half of the password displays on the screen, while the second 
half is sent to the email address you submitted during the registration process. 

2. Alternatively, you may contact your facility Security Administrator to request that he/she perform the 
password reset and unlock your account. 

RESULT: 

You have unlocked your account and reset your password. 

ProviderLink Main Window Overview 
Once you successfully log into ProviderLink, you will see the patient list in the Main Window. You can think of 
this as the main “control panel” used to navigate throughout ProviderLink. The list of patients displayed on the 
Main Window can be considered your caseload, or the patients in your “virtual in-basket” with which you are 
currently working. 

1. Menu Bar – The Menu Bar at the top of the screen is the main navigation method to different parts of 
the ProviderLink application. 

2. List Summary – This section gives an overview of the patients listed in the Main Window and displays 
a total of the following items in your work list: 

• Patients 

• Unread Messages 
• Tasks 

• Reviews Due 
3. View Information – This section displays information about the current view, including the facility name, 

work list name, and the current user. 
4. Patient List – This is the list of patients currently assigned to your work list, usually sorted by the 

patient's last name. You may re-sort the list by clicking on one of the column headers (i.e., ID, 
Reference, etc.) along the green column header row. Each row represents information about one of the 
patients in your work list, or a patient record. 

Figure 7 – ProviderLink Main Window 

Since ProviderLink is a web-based application, everywhere blue or red text displays is a hyperlink or link. Each 
link is a shortcut, and clicking on a link will take you to another page or section within ProviderLink. For example, 
clicking on one of the date links (e.g., 10/01/2009) in the Documents column (see Figure 7 above) will take you 
to that patient's documents. 
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Understanding The Patient List 
The largest portion of the Main Window is the Patient List. The Patient List is divided into rows and columns: the 
horizontal rows represent a patient record; and the vertical columns represent data within each patient record.  
Each of the fields in the Patient List is a link that you can use to navigate into different sections of the patient 
record. The table below lists the columns in the Patient List, what each column represents, and where the link 
leads when clicked: 

Column Represents Link Destination 

Message Icon 

  

New message Create Message screen. Opens a new 
message that relates to this patient. 

Patient Patient name, last name first Patient Information screen 

ID The Unique ID that helps your facility identify the 
patient. Most commonly used to display the 
medical record number. 

Patient Information screen 

Reference A note that helps identify something about the 
patient record. See the description in the “Viewing 
Patient Information” section below. 

Patient Information screen 

Tasks A reminder that some action needs to be taken 
regarding the patient record. 

Tasks screen 

Status Shows whether the patient has been admitted, 
discharged, etc. 

Patient Information screen 

Auths Shows the latest payor authorization received for 
the patient. 

Authorizations screen 

Next Review Shows when the next payor review is due. Scheduled Task Information screen 

Unread Lists the number of unread messages received for 
the patient. 

Unread Messages screen 

Documents Lists the last date a document was filed for the 
patient. 

Documents Folder screen 

 
As you become more familiar with ProviderLink's Main Window, you will learn shortcuts for navigating to the 
sections you wish to use by using the links in the various columns. 

Navigating The Main Window With The List Summary And Column Headers 
You may customize the information displayed on the Main Window using the links in the List Summary and the 
green column headers. By default, the Main Window will show you the list of patients in the work list sorted in 
ascending order alphabetically by the patient's last name.  
To Change the Content on the Main Window Using the List Summary and Column Headers: 

1. From the ProviderLink Main Window (see Figure 7 above), click the Unread Messages link at the top of 
the screen. The Main Window content changes to display all of the unread messages. 
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Note: When you change the work list contents through a List Summary link, the link turns green so 
that you will know what information is being displayed (e.g., The Unread Messages link turns from 
blue to green). 

a. You may change the list to display either the newest or oldest messages by clicking the Date 
column header. The list will refresh with either the newest or oldest unread message appearing first. 

b. You may group messages by Sender by clicking the From column header. The message list will 
refresh with the Senders' names in ascending alphabetical order.  

2. You may wish to see all of the tasks that are pending for your work list. In the List Summary section, 
click the Tasks link. The Main Window will refresh to display only the patients that have tasks pending. 

3. To view items that are overdue or pending, click the drop-down list to the right of Current View and 
select from the following options: 
• Patient List - displays the patient list for the current work list (default option). 
• Unread Messages List - displays a list of unread patient messages.   
• Task List - displays a list of patient tasks.  
• Reviews Due List - displays a list of patient reviews due. 
• Overdue Unread Messages - displays a list of the overdue unread messages.**  
• Message Needing a Reply - displays a list of received messages waiting on a reply that were sent 

to that mailbox.**  
• Message Waiting on a Reply - displays a list of sent messages waiting on a reply that were sent 

from that mailbox. ** 
• Overdue Review Task - displays a list of the overdue review tasks.**  
• Overdue Reminder Task - displays a list of the overdue reminder tasks.** 
• ** Option only displays in the drop-down list if it has been activated by your Facility Administrator. 

4. To return the Main Window to its original state, displaying all of the patients, click Patients in the List 
Summary section. 

Viewing Patient Information 
Now that you are familiar with the Main Window and its various uses, you may drill down to a specific patient 
record by accessing the Patient Information screen. Each patient record can be considered a patient “folder” 
that stores all of the patient's messages, documents, and other vital information that relates to the patient. 
To View Patient Information: 

1. From the Main Window (see Figure 7 above), click a patient name link in the Patient column.  
2. The Patient Information screen displays. The screen is divided into different sections. From this screen, 

you can access anything relating to this patient.  
a. The top section, also labeled Patient Information, includes the patient's name, date of birth, and 

Social Security Number, etc.  
b. The Linked Work Lists section displays the work lists that are linked to this patient record. In other 

words, it shows which department or which staff member is working with this patient record. 
c. The bottom left section, the Status section, shows a brief overview of what has happened with this 

patient record. 

• You can see when the patient was admitted or discharged. 
• You can see when the last payor review was received and when the next review is due. 
• More importantly, you will see how many tasks and unread messages are pending for this 

patient. 
• You may also access the patient's History Items and Audit Trail. 
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 d. The bottom right section, the Linked Mailboxes section, lists the mailboxes that are currently linked 
to this patient record. You may think of these linked mailboxes as message “speed dials” that allow 
you to create messages to send to these mailboxes quickly without having to search for them each 
time. 

Figure 8 –Patient Information screen 

RESULT: 

You have accessed and viewed the information on a patient record. 

 
To View Patient Documents: 

1. The menu bar on the Patient Information screen includes links to functions (e.g., Save, Status, 
Authorizations, Documents, etc.) on other screens that hold information about the patient you are 
viewing. On the menu bar, click Documents (see Figure 8 above). 

2. The list of documents stored with this patient record appears on the Documents Folder screen. 
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Figure 9 – Documents Folder screen 

 
Notice the different types of documents listed in the Types column: e-Form, File, and Fax. These 
document types are described in the Description column. 

3. To view a document: 
a. If the document is stored in one of the patient’s subfolders, click on the folder name in the Name 

column. The screen refreshes and displays all of the documents stored in the subfolder. Click the 
document name link in the Name column. The document displays. 

b. If the document is stored in the home folder, it appears on the screen after the subfolders (see “Fax 
From K. Miller” in the above screen shot), click its name link in the Name column. The document 
displays. 

RESULT: 

You have accessed and viewed documents attached to a patient’s record. 

 
To Move a Patient Document to a Subfolder: 

1. On the Documents Folder screen (see Figure 9 above), click the  Move icon in the first column of the 
document you want to move.  

2. The Move Document screen displays. Click the checkbox in front of the folder. 
3. Click Move. 
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Figure 10 – Move Document screen 

 
Note: In the first column, the  folder icon indicates a subfolder (see the Lab Results folder in 
Figure 9 above). A patient record must have at least one subfolder to move a document from the 
“Home” folder. See the next topic on how to create patient subfolders. 

 

RESULT: 

The Documents Folder screen returns and the document is now stored in the selected folder. 

 
To Add New Patient Folders 
With ProviderLink, you can organize patient documents by creating subfolders. 

1. On the Documents Folder screen, click New Folder on the menu bar (see Figure 9).  
2. The Add Folders screen displays. Enter the subfolder name and a description in the following fields: 

a. Name  
b. Description 

3. To create more than one subfolder, click the More button. The application adds another blank row. 
4. Click Save. 
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Figure 11 – Add Folders screen 

RESULT: 

The Documents Folder screen returns displaying the newly added subfolder. 

Navigating The Breadcrumb Trail 

The ProviderLink application DOES NOT use the Internet Explorer “Back” button  to navigate back to 
other pages. Instead, there is a breadcrumb trail, a navigation tool that allows you to see where the current page 
is in relation to the path you took to get there. The term “breadcrumb trail” comes from the story of Hansel and 
Gretel, who left a trail of breadcrumbs as they walked through the forest so they could trace their way back 
home. In this same way, ProviderLink's breadcrumb trail acts as a “You Are Here” sign and shows you the path 
to get back to a previous screen. ProviderLink's breadcrumb trail is the set of links located near the top of the 
screen just below the menu bar  
You may trace your path back one-step at a time, or you may skip steps and jump back to a previous location 
earlier in the breadcrumb trail. For example, all breadcrumb trails will begin from the Main Window and clicking 
the Main Window link will return you to the Main Window. Clicking the patient name link in the breadcrumb trail 
will return you to the Patient Information screen 
To Use the Breadcrumb Trail to Navigate within ProviderLink: 

1. From an open e-Form (or any other section of a patient record), in the breadcrumb trail, click 
Documents to return to the list of documents. 

2. In the breadcrumb trail, click the patient's name to return to the Patient Information screen. 

Figure 12 – Breadcrumb Trail 

3. Click Main Window in the breadcrumb trail to return to the Main Window. Notice the breadcrumb trail is 
a one-way path back to previous screens. From the Main Window to re-enter the Patient Information  
screen, click the patient's name in the work list. 
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RESULT: 

The breadcrumb trail is a powerful tool for navigating back to the screens you have already visited. After you 
become familiar with how the breadcrumb trail works, you will learn to use it to navigate more quickly 
throughout the ProviderLink application. 

Viewing A Patient's History Items And Audit Trail 
One of the foremost benefits in using ProviderLink for communication is that the system tracks every message 
sent or received regarding the patient in that patient's History Items. The patient's History Items screen will show 
you who the message is from, whom the message is addressed to, whether or not a message was sent 
successfully, when the message was sent, the message subject, and the number of documents attached to the 
message. If the recipient is also online with ProviderLink, you will see whether or not the recipient has read the 
message, when the message was read, and whether or not the recipient sent a reply. Clicking on the message 
subject link will open the message for you. 
If you need more detailed information about the history of the patient's record, you may view the patient's Audit 
Trail. The Audit Trail keeps an accurate record of not only a running history of the messages, but also the 
patient's documents, tasks, and the work lists linked to the patient record. 
To View a Patient's History Items and Audit Trail: 

1. From the Patient Information screen's Status section, click History Items (see Figure 8 above). 
2. The Message History screen displays. The Message History screen shows a complete history of any 

messages sent or received regarding this patient.  
3. By default, the message history is sorted by date and time with the most recent message at the top of 

the list. Like other lists you have seen, you may sort this list by clicking on the column header links. Click 
the From column header to sort the list by message sender. 

4. To return the list to its original state, sorted by date and time, click View Message History in the 
breadcrumb trail. 

Figure 13 – Message History screen 

5. To view a more detailed history of the patient record, click Audit Trail on the menu bar. The Audit Trail 
screen tracks the activities of the users who have been working with this patient record. You may use 
the column header links to sort the list by Date, User Name, Patient, or Audit Entry in order to find an 
entry more quickly. 

6. Click Main Window in the breadcrumb trail to return to the Main Window. 
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Figure 14 –Audit Trail screen 

 
Note: Neither the Message History nor the Audit Trail screens are editable, so you will always be 
assured an accurate record history from the time the patient record was created to the present time. 

 

RESULT: 

You have accessed and viewed the patient’s history items and audit trail. 

 

Changing Your Work List View 
ProviderLink allows you to view the work lists for other users within your facility. This enables you to check the 
status of a patient or access a patient's documents without having to wait for the user to send it to you. Also, if 
you are away from your workstation, another user may access your patients' information. You may also view 
patients in all work lists to get a summary of everyone in your system. 
To Change Your Work List View: 

1. From the Main Window, click the View link in the View Information section in the upper right corner (see 
Figure 7).  

2. The Choose Work List View screen displays. From the View drop-down list, choose the work list you 
wish to view. Click the Submit button.  

Figure 15 – Choose Work List View 

RESULT: 

You have changed the work list view. 
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Working With Patient Records 
ProviderLink stores all messages and documents with their respective patient records. Before you can store a 
document or send a message, you will need to access an existing patient record or create a new one. 
Before creating a new patient record, you will want to prevent duplicating patient records by searching for 
existing patient records first. 
To Search for a Patient Record: 

1. From the ProviderLink Main Window menu bar (see Figure 7), click Lookup > Patient.  
2. The Patient Lookup screen displays. Enter the criteria for which you wish to search, and click the 

Search button. The system will search your existing patient database for records that match your 
criteria. 

Figure 16 – Patient Lookup screen 

 
Note: For the best search results, you may want to only enter the first few letters of the patient's 
name, or use the Unique ID. This way, you will still be able to find the patient record in case the 
patient's name is spelled differently in the record. 

 
3. If the system finds any patient records matching your criteria, you will see a list of matching records at 

the bottom of the Patient Lookup screen. 
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Figure 17 – Patient Lookup screen with search results 

4. If the system found the patient record you were searching for, click one of the blue links to access the 
patient's Patient Information screen. 

5. If the system does not find the record you were searching for, the following message displays: “There 
were no patients found matching that criteria.” You may change your search criteria and try the search 
again. 

RESULT: 

You have accessed an existing patient record in ProviderLink. 

Creating A New Patient Record 
If no patient record exists, you will need to create one before creating any documents or sending any messages 
for that patient. 
To Create a New Patient Record: 

1. From the ProviderLink Main Window menu bar (see Figure 7), click New > Patient.  
2. The Add Patient screen displays. Notice the required fields as noted with red asterisks (*). You must 

complete these three fields in order to successfully save your new patient record. Enter data in the 
required fields, at a minimum. 

 
Note: Although the other fields are optional, it is generally a good idea to enter as much information 
as you have for each patient record. Later, when you create e-Forms for this patient, the system can 
use this data to populate the fields on the e-Form. 

3. The optional Unique ID field is generally used to record the patient's medical record number or other 
identifier that uniquely relates to that patient. 

4. The Column Reference is also optional and is generally used to note something about that patient 
record. For example, you may use this field to remind yourself and your coworkers what is pending 
(e.g., “Placement pending”) or to note the patient's room number. 
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Figure 18 – Add Patient screen 

5. It may be necessary to link your work list to this patient record so that, when you view your work list, this 
patient record will be included in the list. View the Linked Work Lists section in the center of the screen 
to ensure the desired work list appears in the right-most list box and will be linked. 

Figure 19 – Add Patient screen: Linked Work Lists section 

6. When you are finished entering the patient's basic information and choosing the work lists to link, click 
the Save button to save the patient record.  

RESULT: 

The patient record is created and saved. The screen refreshes to show you the saved patient record on the 
Patient Information screen. 
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Logging Out of ProviderLink 
When you are finished working in ProviderLink, you should end your ProviderLink session. Logging out is 
important, especially if you share a computer with other users. This creates an accurate message history and 
audit trail by ensuring that the user ID logged in is actually the user who's working in the system. 
To Log Out of ProviderLink: 

1. From virtually any view, click Logout on the menu bar. 

Figure 20 – ProviderLink Menu Bar: Logout  

2. The system will log you out, show you a log out confirmation screen, and after a few seconds, returns 
you to the ProviderLink Login screen. 

Automatic Logout 
ProviderLink also has an automatic logout feature. For security reasons, the system will log you out after a 
designated period of inactivity. In other words, if the ProviderLink application  determines that you have not 
changed or refreshed a screen within this timeframe, the system will log you out and return to the main 
ProviderLink Login screen. Log into ProviderLink again. 
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Section 2 Summary 
After this hands on tour through the ProviderLink application , you should now know: 

• what to do if you are unable to log into ProviderLink 

• what appears on the Main Window and how the Patient List is organized 
And how to: 

• access the ProviderLink application  

• log into ProviderLink 
• view Patient information 

• move Patient documents 

• create Patient folders 

• use the breadcrumb trail to navigate within ProviderLink 

• view a patient's History Items and Audit Trail 

• change your Work List view 

• look up and create patient records 

• log out of ProviderLink 





       

3. Section III - Using ProviderLink In Your Daily Work 

Skilled Nursing Facilities 
Skilled Nursing Facilities (SNF) have been rapidly changing the way they do business with their local and 
regional hospitals by adopting a paperless referral process made possible by ProviderLink. ProviderLink 
enables these SNFs to view and respond to electronic referral forms and documents that hospitals send to them 
online.  
In most medical communities, timely and accurate decision making regarding potential admissions dramatically 
affects the type and volume of residents the facility admits and thereby affects the financial position of the 
facility. This faster process also improves the revenue cycle for these facilities as they can send and receive 
information, through ProviderLink, to and from their corporate offices, payors, medical directors, and other 
parties related to the residents plan of care. Facility administrators and corporate managers can easily review 
referrals to see where their business comes from and how their personnel respond. 
During and following the admission of its new resident, the SNF can use ProviderLink to manage all of its 
admission-related documents and correspondences such as exchanges with its medical director, dialysis 
centers, pharmacy, billing center, transportation, and other related providers. Communications with Medicaid 
programs and other payors can also be transacted and documented automatically on the patient record 
providing a complete history of all documents, forms, and communications leading up to the admissions 
decision. ProviderLink affords a single screen for managing all communication for both online and offline (i.e., 
fax only) business associates via a bi-directional fax server. Online and faxed-back signature collection can also 
be transacted through ProviderLink. 
ProviderLink also provides a HIPAA compliant way to do discharge planning from a SNF to home or lower level 
of care. ProviderLink is rapidly becoming a best practice for hospital-based discharge planners and improving 
overall work flows for SNF admissions coordinators.  

Processing Online Referrals 
ProviderLink brings much needed organization and accountability to the hospital and SNF referral process. 
Hospital discharge planners can send referral requests with the necessary documentation online instead of via 
fax. Admission coordinators and the other decision makers at a SNF can now access all of the necessary 
information they need regarding any potential resident's admission online. If additional information is needed, 
they can request it directly from the discharge planner online and the reply will be matched up with your patient 
record. 
The hospital's discharge planner creates an online referral package in ProviderLink by print imaging and fax 
imaging all of the necessary documents. A customized online referral form can also be used. The referral packet 
is then sent to the SNF. The SNF admission coordinator can automatically be notified of a new referral in 
ProviderLink by pager, e-mail, or text messaging. The referral packet can be viewed online from any computer 
with Internet access. All of the information you receive is already imaged and can be effortlessly forwarded on to 
the patient's payor or attending physician. Employees who take part in decision making such as bookkeepers, 
administrators, and administrative nurses can be linked to online information in an orderly fashion or access 
referrals themselves. Admission coordinators can broadcast messages to other SNFs to verify remaining patient 
benefit days, and they can request additional information from the hospital by simply replying to the referral 
message. If the SNF decides to make an offer, it can use ProviderLink to reply insuring that both the facility and 
the hospital have a date and time-stamped audit trail of the fact they have formally offered a bed. All of the 
information exchanged between the SNF and the hospital remains indefinitely online for both parties to review 
creating much needed accountability in this process. 
To Process An Incoming Referral (see Figure 7): 

1. From the Main Window screen, check for unread messages. Perhaps the best place to look to see if you 
have any unread messages is in the section at the top of the Main Window screen while viewing the 
Intake work list.  

2. For any referral you receive, the patient's name will appear in the Intake work list. To access the 
patient's record, click the patient's name in the Patient column. The Patient Information screen 
displays. 
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3. In the status section in the lower left corner of the screen, click Unread Messages to view the Unread 
Messages screen. 

4. Any messages you have received regarding this patient that have yet to be read will appear here. You 
will see when the message was received, which facility sent it, the subject, and the number of 
attachments included. Click the Subject to open the message. The View Message screen displays. 

5. The View Message screen gives you more details about the message including the sender (From), the 
recipient (To), the date and time the message arrived, whether or not the sender requested a reply, the 
Subject, the Message itself, and any Attached Documents.  

6. To read the Attached Documents, click the blue document name link to open the document in its 
respective viewer (See the instructions for how To Print A Document if you need to print the 
attachment). 

7. When you are finished viewing the document, you may return to the incoming message screen by 
clicking Main Window in the breadcrumb trail near the top of the screen. 

RESULT: 

You have processed an incoming referral. 

 
To Print A Document: 

1. There are two ways to print the document from the ProviderLink document viewer screen. The best way 
to print the entire document is to click PDF Format on the menu bar. The application will render the 
form as a PDF document and the File Download window will display.  
a. If the Signatures option does not appear on the menu bar, you will need to Save the e-Form first. 

 

Note: If you are using Windows XP with Service Pack 2 installed, Internet Explorer may display a 
security message at the top of the page: and prevent the file from appearing: 
If this occurs, simply click the yellow security message and when the pop-up menu displays, choose 
to DOWNLOAD THE FILE. 

2. On the File Download window, click the Open button to open and view the file. The first page will be the 
bar-coded cover page, followed by the document itself. 

3. Using your PDF reader's print function (usually File  Print), print all pages of the document on your 
desktop or network printer. 

RESULT: 

Once the document is printed, you may close your PDF reader and return to ProviderLink. 

Responding to Referrals 
Discharge planners deal with some of the most time critical communications in the hospital, which include 
keeping up with changing discharge dates and SNF bed availability. They compile referral packages based on 
information from several different systems and paper-based charts. They generally broadcast these referral 
packages to several SNFs to get the best chance for placing their patients and discharging them from the 
hospital. The sooner they can get responses from the SNFs, the sooner they can place the patients and 
discharge them from the hospital. Reducing length-of-stay is an important metric directly tied to a hospital's 
financial viability. 
When the hospital or another referring facility sends a placement request through ProviderLink, the admissions 
coordinator can review the message that contains the admissions packet almost immediately. After reviewing 
the request and the attached documents, the admissions coordinator can usually make the determination to 
accept the request and admit the patient, deny the request, or ask for more information before making a 
determination. Most hospital discharge planners may not be immediately available to take phone calls regarding 
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patients they are trying to refer. Sending your responses to the discharge planners online through ProviderLink 
helps them get your responses immediately and allows them to process their referrals at once. 
To Respond To A Referral Message: 

1. From the View Message screen (the incoming message from the hospital), click Reply on the menu bar. 

Figure 21 – View Message screen 

2. The Create Message screen displays. Notice the message is already addressed to the referring facility 
as the mailbox appears in the To Recipients list box. The From Mailbox should already be chosen for 
you, as well. 

3. If necessary, click the Browse button to select the document(s) you wish to attach to the message. The 
document, once chosen, is added to the Documents To Attach list box. 

 
Note: If you have added a document to the Documents To Attach list box by mistake, you may 
remove it from the list. To remove a document from the Documents To Attach list box, simply 
double-click on the Document name. 

 
4. The message Subject reflects you are replying to a message (RE:). You may change the message 

subject if you wish, though it is generally a good idea for your reply to have a subject related to the 
original message. 

5. You should see the original message automatically quoted in the Message field. Enter your message in 
the Message field. You may use a message template by clicking Templates from the menu bar. You 
may customize or edit the text that was added by the template. 

 

Message Templates are used for adding standardized text to the body of the message. This will 
help the outgoing messages from your facility stay consistent no matter which user sends them. 
With the help of your facility administrator, you can create message templates to accept or turn 
down patient referrals, seek more information, and send bed availability notices. 

6. There is no need to put a check in the Request a Reply check box as the hospital discharge planner is 
expecting your response. 

7. Once you are satisfied with your reply to the message, click Send on the menu bar to send your 
message.  
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Figure 22 – Create Message screen 

RESULT: 

ProviderLink sends the reply and returns you to the incoming message screen (i.e., View Message screen). 

Admitting A Patient To Your Facility And Organizing Your Work Lists 
When you decide to accept a referral and admit a patient to your facility, ProviderLink can help you document 
the admission process and transmit the necessary information to the departments and facilities that need it. 
Your work lists allow you to manage the patient records under your care. By linking your patient records to the 
different work lists in your facility, you are able to move the patient records to the people or departments that 
need them for processing.  
To Update the Patient Record to Record the Admission: 

1. Go to the patient's Patient Information screen (see Figure 24 below). If you are currently viewing the 
Main Window screen, click the patient's Name link. If you are viewing another part of the patient's 
record, click the patient's name in the breadcrumb trail. The Patient Information screen displays. 

2. To help ProviderLink properly store the patient record, enter the patient's account number or medical 
record number in the Unique ID field. 

3. Enter the patient's Social Security Number in the SSN field. 
4. Update the Column Reference field with information about the bed offer and your response. You may 

add any information in this field to track referrals. 
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The Column Reference field is used for documenting information about the patient's status, the 
patient's current setting, or anything else about the patient that may not fit into any other field. It can 
also serve as a reminder for you or a coworker, much the same way as a note attached to the 
patient record. 
Anything entered in the Column Reference field on the Patient Information  screen will appear on 
the Main Window screen in the Reference column. This allows you to see the reminders on the Main 
Window screen as soon as you log in. 

 
5. Link the patient record to the Business Office work list. 

a. In the middle section of the Patient Information screen, find the Linked Work Lists section. 
b. The list box on the left, All Available Work Lists, shows all of the work lists that exist in the system 

that is not linked to the patient record. There you should find the Business Office work list. 
c. Click the Business Office work list to select it. 
d. Click the Add button to add the Business Office work list the list of Work Lists Linked to this Patient. 

6. To save your changes, click Save on the menu.  

Figure 23 –Patient Information screen 

RESULT: 

You have updated the patient record to include admission information. Notice the comments you entered in 
the Reference column. 
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Managing Your Work Lists 
Patient records are often moved through a workflow. Tasks and patients can be easily moved from one work list 
to another and so on to complete a workflow. When a patient is moved from one work list to another, all of the 
properties of that patient such as tasks, overdue items, etc., move to the new work list.  
After your portion of the patient's workflow is complete, you may remove a patient from a work list. The system 
will display a message if the patient records has any unread messages, incomplete tasks, or overdue items. If 
yours is the last work list linked to the patient, you will need to process all outstanding items (i.e., all unread 
messages and undone tasks) before removing the patient from your work list. 
To Link Another Work List to the Patient Record: 

1. From the Patient Information screen, locate the Linked Work Lists section in the center of the screen 
(see Figure 24 above). 

2. Select the work list you wish to add from the ALL AVAILABLE WORK LISTS list box and click the Add 
button. The chosen work list will be added to the WORK LISTS LINKED TO THIS PATIENT list box. 

3. On the menu bar, click Save.  

RESULT: 

The system saves patient record and adds it to the linked work list(s). 

 
To Remove a Work List From the Patient Record: 

1. From the Patient Information screen, locate the Linked Work Lists section in the center of the screen 
(see Figure 24 above). 

2. Select the work list you wish to remove from the WORK LISTS LINKED TO THIS PATIENT list box and 
click the Remove button. The chosen work list will be removed from the WORK LISTS LINKED TO 
THIS PATIENT list box. 

3. On the menu bar, click Save. The system will check to see if there are any unread messages or 
incomplete tasks and, if there are, it will display an “Open Items” message. Review the message and 
click the Remove button. 

4. If there are no other work lists linked to the patient record, the system will not allow you to remove the 
work lists and will display a message. Click the Continue button to return to the patient record and close 
the outstanding items. 

RESULT: 

Once the patient is removed from the work list, the updated work list appears with the remaining patient 
records. 

Adding Documents to Patient Records 
ProviderLink enables you to store patient-related documents with each patient record. Any document that is sent 
to you online or faxed into the system can be added to a patient's record. You can also use the online e-Forms 
function in ProviderLink to create documents. In addition, virtually any paper document or report you can print to 
a local printer can be added to a ProviderLink patient record and be sent in a message to another facility. 
To Add a Hard Copy Document to a Patient Record (Fax Attach): 

1. From the Patient Information screen (see Figure 24 above), click Documents on the menu bar to view 
the Documents For Patient screen. The Documents Folder screen displays. 
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2. On the menu bar of the Documents Folder screen, click Add Document  Add By Fax.  

Figure 24 – Documents Folder screen 

3. On the Fax Attach screen in the Document Name field, enter a name that fits the type of document you 
are adding. 

4. Click Print on the menu bar or the Print button. The system will generate a bar-coded cover page. 

Figure 25 – Fax Attach screen 

5. After the cover page prints, click Close on the Fax Attach screen’s menu bar to close the cover page 
and return to the Documents Folder screen. 

6. Once the cover page prints, place it on top of the documents and fax the package to the number 
indicated on the cover page. After the fax successfully sends, the document will be listed on the 
Documents Folder screen (this screen may need to be refreshed). 

7. On the Documents Folder screen, click the document Name link to view the document you added. 

RESULT: 

A hard copy of a document has been added to the patient record by using the Fax Attach function. 

 
To Add a Document From Another System to a Patient Record (Print Attach): 

1. From the Patient Information screen (see Figure 24), click Documents on the menu bar to view the 
Documents Folder screen. 

2. On the menu bar of the Documents Folder screen (see Figure 25), click Add Document  Add By 
Print Job.  

3. The Print Attach screen displays. In the Document Name field, enter a name that fits the type of 
document you are adding. 

4. Click the Print button.  
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Figure 26 – Print Attach screen 

5. The Print Now screen displays and the system is ready to receive the document from another 
application. Leaving the ProviderLink windows open, open the system that contains the document, and 
prepare to print it. 

6. Change the printer options to print the report with the ProviderLink Virtual Printer. The document will 
spool to the printer and the ProviderLink Internet Gateway dialog box displays. 

7. After the status bar fills and the dialog displays the message “The send completed successfully,” click 
the Close button. 

8. Minimize or close the system and return to ProviderLink. 
9. Close the Print Now window. The Documents For Patient screen will refresh and you should see the 

document you print-attached added the list. 

RESULT: 

A document, from another system, has been added to the patient record by using the Print Attach function. 

 

 

Note: Documents added to the patient record using the Add By Print Job feature can only be 
attached to a message and faxed if the document is saved as a PDF file. However, documents 
saved as Word, text, PDF files, etc. using the Add By Print Job feature can all be sent online 
(electronically) using ProviderLink. 

 
To Add An Electronic Form (e-Form) to a Patient Record: 

1. From the Patient Information screen's menu bar (see Figure 24), click Documents to view the 
Documents Folder screen. 

2. On the menu bar of the Documents Folder screen, click e-Forms to view the available forms. 
3. From the drop-down list, select the e-Form.  

Figure 27 – Documents Folders screen: e-Forms  list 
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4. The system will display the e-Form on the Form screen. Complete the fields on the e-Form, paying 
particular attention to the required fields as indicated by the red asterisks. 

5. After completing the form, click Save on the menu bar. 
6. To have the system check to see if the form's required fields have been completed correctly, click 

Check on the menu bar After checking the form, the system will display red text below the fields to show 
any errors. Fix the errors and check the form again. 

7. Once you are confident there are no errors on the form, click Save on the menu bar 
8. To close the form, click Save and Close on the menu bar. 

Figure 28 – e-Form example 

RESULT: 

The completed e-Form has been saved and added to the patient record. 

Adding Signatures To Documents 
Through ProviderLink, you have the ability to sign any document, whether added electronically or by fax 
attaching. Medicaid and most skilled facilities require a physician's signature for the document to be valid. 
Depending on your workflow and practices, you can easily obtain and process these signatures on any 
ProviderLink document. 
There are three ways to obtain signatures for your e-Forms and other documents in ProviderLink: 

1. electronic signatures using a ProviderLink user name and password 
2. sending the document to the signor's office with a bar-coded, fax-back cover page 
3. or printing the form for signature and scanning it into ProviderLink with a bar-coded cover page. Once 

the document is signed, the signature is stored with the document and, in the Documents list, is tagged 
with the signature icon. When the signed form is transmitted to another facility, a copy of the original 
form is attached to the signed form. 

Electronic Signatures 
Most state Medicaid departments and their subcontractors, most skilled facilities, and various other healthcare 
organizations will accept electronic signatures on documents. In fact, most of these organizations have a written 
policy for electronic signature acceptance. You will need to verify your organization's electronic signature policy 
before using it to sign your ProviderLink documents. 
  
Document Revision Level 3.0                                                          - 32 -                                                                                      October 2009 
2009 Compuware Corporation: All Rights Reserved - Confidential and Proprietary 
 



Using ProviderLink in Your Daily Work       

To Electronically Sign A Document: 
1. From the menu bar of the e-Form or document you wish to sign, on the document viewer screen, click 

Signatures  Electronically Sign.  

Figure 29 – e-Form: Signatures option 

a. If the Signatures option does not appear on the menu bar, you will need to Save the e-Form first. 
2. The Electronic Signature screen displays. Select your name from the Name (“I am...”) drop-down list 

and enter your Password. Click the Sign Document button. 

Figure 30 – Electronic Signature screen 

RESULT: 

After you enter the correct password and submit the signature, the system will return you to the form or 
document you signed. Notice the menu bar on the e-Form screen now has fewer options. 

 

 

HIPAA regulations require that healthcare organizations archive a copy of every form that is signed 
or sent to other facilities. Because of this, ProviderLink locks the form as soon as it is signed or 
attached to a message and it may not be altered. When you need to change the data on the form, 
you must create a copy of the form with the SAVE COPY option on the menu bar and change the 
form data on the copy. If required, the new copy of the form will need to be signed. 
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Printing The Document for Signature 
After completing a form, you may print the document and attach it to the patient's chart so that the physician can 
sign it. With the document, the system will generated a bar-coded cover page that is used to scan (fax) the 
signed document back into the patient's document list. The signed document is archived with the patient's 
record and can be transmitted to anyone who needs it.  
To Print The Document For Signature: 

1. From the menu bar of the form or document you wish to sign, on the e-Form screen, click Signatures 
 Print for Signature. (see Figure 30). The system will render the form as a PDF document and you 

will be asked to open it using your PDF reader.  
a. If the Signatures option does not appear on the menu bar, you will need to Save the e-Form first. 

 

Note: If you are using Windows XP with Service Pack 2 installed, Internet Explorer may display a 
security message at the top of the page: and prevent the file from appearing: 
If this occurs, simply click the yellow security message and, when the pop-up menu displays, 
choose to DOWNLOAD THE FILE. 

 
2. Click the Open button to open your PDF reader and view the file. The first page will be the bar-coded 

cover page, followed by the document itself. 
3. Using your PDF reader's print function (usually File  Print), print all pages of the document on your 

desktop or network printer. 
4. Place the form where the physician can sign it. 
5. Once the form is signed, place the bar-coded, fax cover page on top of the form and fax it to the 

number on the cover page.  

RESULT: 

Once the ProviderLink application receives the fax and reads the bar code, the signed document will appear 
in the patient's documents list. 

Sending the Document To a Fax Contact for Signature 
If the physician is not in your facility to sign the document, you may use ProviderLink to send the document to a 
fax machine for signature. A fax-back cover page is provided so that, after the document is signed, the physician 
may send it back to you through ProviderLink. When it arrives, the system will automatically route the signed 
document to the list of documents in the patient's record. 
To Send the Document to a Fax Contact for Signature: 

1. From the menu bar of the form or document you wish to sign, on the e-Form screen, click Signatures 
 Send for Signature (see Figure 30). The Create Message screen displays with the document 

already attached, the Subject is completed.  
a. If the Signatures option does not appear on the menu bar, you will need to Save the e-Form first. 

2. Click the To Recipients drop-down arrow, and select the appropriate distribution list or mailbox for the 
office of the person whose signature you need. 

3. If the mailbox does not appear in the drop-down list, you can look it by clicking the Search button. The 
Facility Search pop-up window displays. Enter the search criteria. Select the appropriate facility from the 
search results. Close the screen to return to the Create a Message screen. 

4. On the Create a Message screen, enter an appropriate message Subject (i.e., “Level 1 PASARR”). 
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Note: The message subject is important for several reasons. First, the subject alerts the recipient of 
your message to the potential importance of your message. Second, the message subject may 
assist the recipient to route your message to the person or department who can best complete your 
request. Also, ProviderLink uses your message subject as the link to open the message and 
displays it in the Message History. A descriptive subject should give users an idea of what the 
message contains without having to open the message itself. 

 
5. If necessary, enter a message.  
6. If there are any required form fields that have not been filled in or formatted correctly, you will see red 

error messages highlighting the errors. To fix the errors, you will need to return to the form by clicking 
the document name in the breadcrumb trail. 

7. When you are ready to send the message, click Send on the menu bar.  

 

Note: When the physician signs the document and faxes it back using the bar-coded, fax-back 
cover page, ProviderLink will read the bar code and route the signed document to the patient's 
record. You will see an unread message for that patient appear on your work list. When the signed 
document arrives, the system will also mark the reminder task as complete. 

 
RESULT: 

The system will send the document for signature, create a reminder task (to remind you that you are waiting 
for a signature), and return you to the Form screen. 

Sending Reviews to Payors 
ProviderLink makes the process of sending clinical reviews to insurance payors easier and more efficient. When 
using tasks, as described above, ProviderLink will remind you when reviews are due and you can send a 
message containing the review from the task itself. 
To Send a Review to a Payor from the Tasks for Patient screen: 

1. If you are using tasks to remind you when a review is due, click Tasks from the Status section on the 
Patient Information screen (see Figure 24).  

2. The Tasks screen displays with the listed tasks. Find the task for which you are sending the review and 
click the task's Description link. 

Figure 31 – Tasks screen 

3. The Scheduled Task Information screen displays. Choose the facility to which you want to send the 
review from the Send A Message To drop-down list and click the Send Message icon (i.e., envelope).  

  
Document Revision Level 3.0                                                          - 35 -                                                                                      October 2009 
2009 Compuware Corporation: All Rights Reserved - Confidential and Proprietary 
 



Using ProviderLink in Your Daily Work       

Figure 32 – Scheduled Task Information screen 

4. The Create Message screen displays with the message already addressed to the chosen facility. 
5. Select the necessary clinical documents from the Available Documents drop-down list or copy and 

paste the clinical data into the Message field. 

 

Note: When including an attachment to a message to a fax-only facility, only documents saved as 
PDF or TIF files (i.e., faxes) can be sent. If other file types are attached (e.g., Word doc, text file, 
Excel spreadsheet, etc.), a warning will display stating that this file type cannot be sent to a fax-only 
facility. 

6. Fill in a message Subject. Be sure the message includes the patient reference number or other 
insurance information to identify the patient. 

7. Because you will want the insurance payor to respond to you with authorization information, click the 
Request a Reply check box.  

8. You can be reminded that you are awaiting a reply from the payor by selecting the Create a Reminder 
Task check box. 

9. When you are satisfied with your message, click Send on the menu bar. The system will send the 
message and return you to the Scheduled Task Information screen. 

 

Regardless of whether the message recipient is online or fax-only, you will send the message the 
same way. ProviderLink will determine the facility type and send the message accordingly. 
If the recipient is online, the receiving facility will receive your review as an unread message in their 
work list. They will reply to you online, as well. 
If the facility is fax-only, they will receive your review over their fax, complete with a bar-coded, 
ProviderLink fax-back cover page. When the facility replies, they will use the fax- back cover page. 
With either type of reply, you will receive the response as an unread message attached to the 
patient record. 

 
10. Now that you have completed the task, from the Scheduled Task Information screen’s menu bar click 

Complete  Without Note. The system will return you to the Tasks screen. 
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RESULT: 

A clinical review has been sent the payor via an online message or fax. 

 
To Send a Review to a Payor From the Patient Information  screen: 

1. From the Patient Information screen Linked Mailboxes section, click the payor’s name link. The Create 
Message screen displays with the message already addressed to the chosen facility. 

2. Follow Steps 4 to 9 above to send the review to the payor. When finished, you will return to the Patient 
Information screen. 

Handling Payor Responses 
Insurance payors will send authorizations to you through ProviderLink. Whether they send the message through 
an online reply or with a fax-back cover page, the system will route the message to the patient record and it will 
appear as an unread message.  
If the payor is online, they will post the authorization to the patient record through ProviderLink's authorization 
feature. When the authorization is posted, the patient's authorization date is updated on the Main Window 
screen and on the Patient Information  screen. The payor can also assign you a task for when the next review is 
due. For authorizations received from fax-only payors, you can document the authorization and set up the next 
review task. 
To Read Messages: 

1. From the Patient Information screen Status section (see Figure 8), click the Unread Messages link. The 
Unread Messages For Patient screen displays with the oldest message appearing at the top of the list. 

2. Click the Subject link for the message you wish to read. The View Message screen (see Figure 22) 
displays. 

3. Each message shows you the related patient information, who the message sender and recipient are, 
when and how the message was sent, the message subject and text, and any document attachments. 
Also, you can see if the sender requested a reply. 

4. If you wish to reply to the message, click Reply on the menu bar. The Create Message screen (see 
Figure 23) will appear with the To Recipient and Subject fields already populated for you. Fill in the 
rest of the fields accordingly, and click Send on the menu bar to send the reply. 

5. If you wish to forward the message to another user or facility, click Forward on the menu bar. The 
Create Message screen will appear with the Subject and Message fields already populated for you. Fill 
in the rest of the fields accordingly, and click Forward on the menu bar to forward the message. 

6. If you wish to mark the message unread, click Mark Unread on the menu bar. You will return to the 
Unread Messages for Patient screen. 

7. Once you have finished reading the message, you may return to the Unread Messages For Patient 
screen by clicking the Unread link in the breadcrumb trail. 

RESULT: 

Patient messages from a payor have been accessed and read. 

 
To Post Authorizations Received From Fax-only Payors: 

1. From the Patient Information screen Status section (see Figure 8), click the Current Authorization link, 
or click Authorizations from the menu bar.  

2. The Authorizations screen displays. From the menu bar, click Add Authorization.  
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Figure 33 – Authorizations screen 

3. The Authorization Information screen displays. If necessary, select the correct insurance payor from the 
Issuer drop-down list. 

4. Fill in the authorization number in the required Authorization field. 
5. Enter the date range the authorization covers in the From Date and To Date fields. 
6. You may enter comments about what the authorization covers in the Viewable Comments or Non-

Viewable Comments fields, if desired. 
7. In the Next Review section, use the Review Date field to set up a task for the date the next review is 

due. 
8. Once you have documented the authorization, click Save on the menu bar to save the authorization. 

Figure 34 – Authorization Information screen 
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RESULT: 

The authorization from a payor has been posted to the patient record and a task created for the next review 
date. 

Changing the Patient's Discharge Date 
As with the patient's admission date, you will want to update the patient record and inform the patient's 
insurance payor(s) of the patient's discharge. You can do this by changing the patient's status on the Patient 
Information  screen. 
To Change the Patient's Discharge Date: 

1. From the Patient Information screen Status section (see Figure 8), click the Last Discharge Date link. If 
necessary, enter the patient's Unique ID in the required field. 

2. The Patient Discharged screen displays. Enter the admission date in the Date of Above Status 
Change field by entering the date or choosing the date using the calendar pop-up tool. 

3. You may use the Viewable Comments field to note the conditions or circumstances under which the 
patient was admitted. 

4. If there is a payor contact linked to the patient, you may choose to send a message to notify the payor 
of the patient's change in status by clicking the payor's check box (located below the Viewable 
Comments box). 

5. Click Save on the menu bar to change the patient's status and send the message(s) to the payor(s). 

Figure 35 – Patient Discharged screen 

RESULT: 

The system changes the patient's Status field to “Admitted,” and updates the Current Admission Date.  
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Section 3 Summary 
After this demonstration of how the ProviderLink application  assists you in your daily work, you should know 
how to: 

• receive and respond to patient referrals 

• admit a patient to your facility 

• manage your work lists 

• add documents to patient records 
• add signatures to documents 

• send reviews to payors 

• process payor responses 

• change the patient's discharge date 
 



       

   

4. Section IV - Appendices 

Appendix A – Troubleshooting ProviderLink Issues 
This section describes how to troubleshoot issues encountered while using ProviderLink. The table below lists 
common ProviderLink functions and respective issues, the steps you can take to resolve the issue, and some 
explanation of why the issue occurred. Most issues can be resolved using the instructions cited in this guide and 
the references to the appropriate sections are noted in the “Steps To Resolve” where appropriate. 

Function Issue Steps To Resolve What To Do Now 

Can you access other 
websites (e.g., 
cnn.com, etc.)? 

Yes – Contact the 
ProviderLink Help Desk to 
determine if there are any 
system issues. 
No – Contact your IT 
network staff to determine 
if your facility is having 
network or Internet issues.

The ProviderLink Login 
screen does not appear. 

Are you trying to 
access the correct web 
address? 

Be sure you are entering 
https://healthcare.covisint.
com into the web 
browser's Address bar.  

I forgot my password 
and/or user ID. 

Go to the Covisint login 
screen 
(https://healthcare.covis
int.com) and click 
“Forgot your 
password?” or “Forgot 
your User ID?” 

For password, enter your 
User ID and answer your 
challenge question to 
reset your password. 
For user ID, enter your 
email address, and your 
user ID will be emailed to 
you. 

Unable to log into 
ProviderLink 

I've been suspended. If you enter an incorrect 
password 5 times 
within 5 minutes, your 
Covisint-ProviderLink 
account will be locked 
due to an excessive 
number of invalid login 
attempts. 
Go to the Covisint login 
screen 
(https://healthcare.covis
int.com) and click 
“Forgot your 
password?” 

In order to unlock your 
account, simply use your 
challenge question and 
answer to reset your 
password. Or your Facility 
Administrator can 
unsuspend your user 
account. 

Patient Records I can't find the patient 
record I was working 
with. 

Search for the patient 
record. 

ProviderLink saves patient 
records indefinitely. 

https://healthcare.covisint.com/
https://healthcare.covisint.com/
https://healthcare.covisint.com/
https://healthcare.covisint.com/
https://healthcare.covisint.com/
https://healthcare.covisint.com/
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Function Issue Steps To Resolve What To Do Now 

I sent a message to a 
facility. How can I be 
sure it was received? 

Check the History 
Items for the patient. 

The History Items list 
records every incoming 
and outgoing message for 
the patient and whether or 
not a message is sent 
successfully. 

Messaging 

A message I was 
reading isn't in the 
Unread Messages list. 
Where can I find it? 

Check the History 
Items for the patient. 

Once you've read a 
message, it is removed 
from the Unread 
Messages list. 

I faxed my document 20 
minutes ago and I don't 
see it in the patient's 
Documents list. 

Look for the document 
in your facility's 
Incoming Fax Folder. 
Route the document. 

When ProviderLink is not 
sure where to route a 
document, the system will 
route the document to the 
Incoming Fax Folder. 

I don't see the 
ProviderLink Virtual 
Printer in my list of 
printers. 

You must install the 
ProviderLink Virtual 
Print Driver before you 
can print attach any 
documents. 

The ProviderLink Virtual 
Print Driver can be 
downloaded and installed 
from the Help menu on 
the Main Window. 

Documents 
Management 

The ProviderLink Print 
Driver gives me an error 
message: “Please attach 
a case within 
ProviderLink before 
attempting to print.”  
 

Follow the steps on 
how to print attach a 
document into a 
ProviderLink patient 
record. 
Also, contact 
ProviderLink Customer 
Support for newest 
version of the Virtual 
Print Driver. 

You must first start in the 
patient's record and 
choose to add a 
document by print job 
before printing using the 
ProviderLink Virtual 
Printer. 
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Appendix B – ProviderLink Quick Reference Guide 
 

ProviderLink Quick Reference Guide 

To Log Into ProviderLink 

1. In the IE window Address bar, type https://healthcare.covisint.com and press the Enter key. 
The Covisint login screen will appear. 

2. Enter your User ID and Password. 
3. Click Login. The Covisint Healthcare home page displays. In the left-hand menu, under 

Secured Applications, click ProviderLink to launch the application, which opens in a new 
window. 

To Unsuspend Your ProviderLink Account 

If you try to log in and fail 5 times in 5 minutes, the system will suspend your user account and you will 
need to reset your password. In order to unlock your account, simply use your challenge question and 
answer. This will automatically unlock your account. 

1. From the https://healthcare.covisint.com page, click “Forgot your password?.”  
a. The screen expands displaying a field to enter your User ID and then click Submit. The 

Reset Password screen displays. 
b. Enter the answer to your challenge question in the Challenge Answer field and click 

Submit. 
c. Upon successful submission, the first half of the password displays on the screen, while 

the second half is sent to email address you submitted during the registration process. 
2. Alternatively, you may contact your facility Security Administrator to request that he/she 

perform the password reset and unlock your account. 
 
 
 
 
 
 
 
 
 
 
 
 

https://healthcare.covisint.com/
https://healthcare.covisint.com/
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ProviderLink Quick Reference Guide 

To Check ProviderLink For And Read Incoming Messages 

1. Once logged into the system and viewing the Main Window screen, click the View link in the 
top right corner. 

2. Click the View drop-down arrow and choose your Work List. Choose Default Incoming Fax 
Folder to view the list of incoming faxes. 

3. Click Submit to display your Work List. The Main Window screen will appear. 
4. When viewing your work list, the number of Unread Messages will appear at the top of the 

screen and in the Unread column in the patient list. Clicking either of these numbers will 
display the message list. 

5. To read a message, click the patient's name link in the Patient column. 
6. When the Patient Information screen displays, click the Unread Messages link in the Status 

section in the bottom right corner. 
7. When the Unread Messages for Patient screen displays, you may read a message by clicking 

the Subject link. The message will appear on the Read Message screen. 
8. From the menu bar, you may Reply, Forward, Mark the message Unread, view information 

about the sender Contact, and Print the message. 
9. If there are any Attached Documents, you may click the links to read the attachments. 
10. To go back and read more unread messages, you may click on Unread Messages or the 

patient's name in the breadcrumb trail at the top of the screen. 
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ProviderLink Quick Reference Guide 

To Process An Incoming Fax Message 

1. From the Default Incoming Fax Folder screen, click the Get Next Fax button. The first page of 
the fax message displays. 

2. Once you determine which provider the message is from, click the Originator drop-down list to 
see if the provider appears. If so, select the provider. 

3. If the provider is not in the Originator list, click the Search button to bring up the Facility 
Search window. 

4. Enter the necessary criteria to search for the provider and click Search. The system will 
display the search results based on the criteria you specified. If the provider you are searching 
for does not appear, modify the search criteria and repeat the search. 

5. If the provider still does not appear, you may need to create the facility. See “To Create a New 
Fax-Only Facility.” 

6. Identify the type of document and enter it into the Document Name field. 
7. Next to the Patient Name field, click Search. Use the Patient Lookup window to find the patient 

record. If no patient record exists, you may need to create a new one.  
See “To Create a New Patient Record.” 

8. Click the Mailbox drop-down arrow to display the list of mailboxes to route the message. 
Choose the appropriate recipient's mailbox. 

9. For multi-page fax messages, click the page numbers to check if multiple messages were sent 
in the same transmission. If so, you will need to split the message and route each part 
separately. To set up the split, click the More button to bring up a new row for each message 
part. The Document Name, patient Name, and Mailbox will carry forward to each new row and 
may need to be changed. 

10. In the Pages field, enter the pages to send for each message part. For all pages, accept the 
default “All” value.  

11. Once you have filled in all of the fields for each message part, make sure Remove document 
from the fax queue is selected and click the Save and Next button to pull up the next fax 
message. 

To Create A New Patient Record 

1. From the Patient Lookup screen, click New on the menu bar. The Patient Information screen 
displays. 

2. Fill in, as a minimum, the patient's Last Name, First Name, and Birthdate in the respective 
required fields. You do not have to select a work list. 

3. Click Save. The patient's name will appear in the Patient field. 
Note: This also works from the Main Window screen. Click New > Patient on the menu bar. 
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ProviderLink Quick Reference Guide 

To Create A New Fax-Only Facility 

1. From the Main Window, click Lookup > Facility. The Facility Lookup screen displays. Click 
New on the menu bar. The Fax Facility Information screen displays. 

2. Enter name of the provider in the Fax Facility Name field, which is the only required field. 
3. If needed, enter the: Main Phone Number; City; State/Province; Zip; and County. 
4. Choose the type of provider from the All Facility Types list box and click the Select button. 

There may be more than one applicable provider type. If you have added a facility type and 
want to remove it, you may highlight the facility type and click Unselect. 

5. When you have checked your entries for accuracy, click Save.  

To Add Documents To A Patient Record With The Virtual Print Driver 

1. Start from the patient's Patient Information screen, and click Documents on the menu bar. 
2. When the Documents screen displays, click Add Document on the menu bar, and then select 

Add By Print Job from the drop-down list. 
3. When the Print Attach pop-up window displays, enter a name in the required Document Name 

field. 
4. Click Print. The Print Now window displays and the system is ready to receive the document. 
5. Without logging out of ProviderLink, open the document you wish to print.  
6. For most applications, click File > Print, select “ProviderLink Virtual Printer” from the list of 

printers, and click Print.. 
7. The ProviderLink Internet Gateway window will appear and the document will be sent to the 

patient record. When you see “The send completed successfully” message, click the Close 
button. 

8. Minimize the document window to get back to the ProviderLink Print Now window and click 
Close. 

9. Navigate back to the ProviderLink window (look for the “Documents Management” button on 
the task bar) and the document will appear in the list. 

10. You may click the Document Name link to ensure the authorization was added successfully. 
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ProviderLink Quick Reference Guide 

To Add A Paper (hard copy) Document To A Patient Record 

1. Start from the patient's Patient Information screen, and click Documents from the menu bar. 
2. When the Documents screen displays, click Add Document on the menu bar, and then select 

Add By Fax from the drop-down list. 
3. When the Fax Attach screen displays, type a Document Name and click Print.  
4. You will see a bar-coded cover page appear. Click Print from the menu bar and print the 

document to your printer. 
5. Take the bar-coded cover page, PUT IT IN FRONT of the document you wish to add, and fax it 

to the number on the cover page. After the fax sends the document to ProviderLink, the 
document will appear in the patient's list of documents (i.e. on the Documents screen). 
Note: It may take a few moments for the document to appear in the patient's documents list, 
depending on the number of pages in the fax message. 

To Send A Message Through ProviderLink 

1. Start from the patient's Patient Information screen, and click Send Message from the menu 
bar. The Create Message screen displays. 

2. Select the provider name from the To Recipients drop-down list. If the provider does not 
appear in the list, you may search for the facility in the same way as in “To Process an 
Incoming Fax Message” steps 3-5. 

3. The From Mailbox should already be set for you.  
4. Click the Browse button to search for and select the documents you wish to attach.  

Note: When including an attachment to a message to a fax-only facility, only documents saved 
as PDF or TIF files (i.e., faxes) can be sent. If other file types are attached (e.g., Word doc, text 
file, Excel spreadsheet, etc.), a warning will display stating that this file type cannot be sent to a 
fax-only facility.  

5. Enter an appropriate Subject, which will appear on the fax cover page. For example, “OP 
Requisition.” 

6. You may enter a Message that will appear on the fax cover page. You may also choose to use 
a Template to enter a standardized Message. 

7. If you want the recipient to reply, click the Request a Reply check box. You may want to 
deselect the Create a Reminder Task check box if you do not wish to be reminded you are 
requesting a response. 

8. Click Send. The message will be delivered to the recipients you specified. 
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ProviderLink Quick Reference Guide 

To View Another Work List 

1. Start from the Main Window screen and click the View link in the top right corner (it will say 
“View” followed by the work list name). The Choose Work List View screen will appear. 

2. Click the View drop-down arrow to display the list of work lists and folders available for your 
organization. 

3. Select the work list you wish to view. 
4. Click the Submit button to view the work list. 

To Set A Reminder Task On A Patient Record 

1. Start from the patient's Patient Information screen. 
2. In the bottom left corner in the Status section, click Tasks. The Tasks screen displays. 
3. On the menu bar, click New. The Scheduled Task Information screen displays. 
4. Enter the task Description and Due Date. You may use the calendar pop-up window by 

clicking the calendar icon . 
5. In the Non-viewable Comments field, you may enter any special instructions or other 

comments regarding this task.  
6. Click Save to save the task and set the reminder. You will return to the Tasks screen. 

To Complete Or Delete (remove) A Task 

1. Start from the patient's Patient Information  screen. 
2. In the bottom left corner in the Status section, click Tasks. The Tasks screen displays. 
3. Find the task you wish to complete and click the Description link. The Scheduled Task 

Information screen displays for that task. 
a. To COMPLETE the task, click Complete on the menu bar and then select either With 

Notes or Without Notes. If you chose to complete the task with notes, enter the notes in 
the Viewable Comments field and click the Complete Task button. 

b. To DELETE the task, click Delete on the menu bar and then select either With Notes or 
Without Notes. If you chose to delete the task with notes, enter the notes in the Viewable 
Comments field and click the Delete Task button. 

4. After completing or deleting the task, you will return to the Tasks screen. 
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To View A Patient's Message History And Audit Trail 

1. Start from the patient's Patient Information  screen and click History Items to view the 
Message History screen and every message sent or received relating to that patient. 

2. To view a message, click the message Subject link. 
3. Clicking History in the breadcrumb trail will take you back to the Message History screen. 
4. For a more detailed record of the patient record history, click Audit Trail on the menu bar. This 

will show you a detailed history of virtually every activity regarding the patient record including 
what occurred, when it occurred, and the associated user name and patient record.  

To Remove A Patient Record From Your Work List 

1. Start from the patient's Patient Information screen in the Linked Work Lists section. 
2. In the Work Lists Linked To This Patient list, select your work list name and click Remove. 
3. When the system asks you to confirm, click Remove.  
4. The system will display your updated work list with the patient record removed. 

To Log Out Of ProviderLink 

1. From almost any screen, click Logout on the menu bar. 
2. After you have successfully logged out, you may close the browser window. 

Note: Be sure to log out before you close the browser window to prevent any unauthorized 
access to protected healthcare information. 

To Get Help 

1. Click Help on the menu bar of any ProviderLink screen. 
2. Contact YOUR facility administrator. 
3. Contact the ProviderLink Help Desk at 866-373-0878.  
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